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Topics to be covered

Part 1 (previous presentation)
◦ InterSpec’s Capabilities

◦ A demonstration of  using InterSpec for analysis

◦ Using InterSpec
◦ Interacting with spectra, viewing options, spectrum files, saving work, reference photopeak lines, peak-fitting, nuclide search

◦ Energy calibration
◦ Manual adjustment, graphical adjustment, fitting from photo-peaks, multi-file, non-linear deviation pairs

◦ Fitting activity and shielding
◦ Multiple isotopes, shielding types, limitations

Part 2 (this presentation)
◦ More display options

◦ Nuclide ID
◦ Nuclide Search

◦ Reference Photopeak lines 

◦ Other useful tools in InterSpec
◦ Dose, gamma flux, nuclide decay, …

◦ Creating detector response functions
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More Display Options



More Display Options – scaling spectrums

By default, InterSpec will live-time normalize the background and secondary spectrum to the foreground
◦ You can manually enter the scale factor you want on the “Spectrum Files” tab

From the View menu you can select Show Y-Axis Scalers that let you graphically scale the spectra
◦ Particularly useful for comparing spectra against reference spectra
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More Display Options – peak labels

You can choose to show peak energy, nuclide, gamma, and/or a user label for each peak

You can add or edit the user label using the “Peak Manager” tab, or the “Peak Editor”
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More Display Options – chart options

Linear Y Scale: occasionally useful when squinting at tiny peaks or features

Vertical/Horizontal Lines: sometimes useful for reports or HPGe spectra

Compact X-Axis: good for screens with limited real-estate

Hide Tool Tabs: entire screen becomes spectrum; the tabs contents become available in the “Tools” menu
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More Display Options – multiple detectors

If  the spectrum file contained multiple detectors, you can control which ones the data is displayed from

◦ Can be useful to isolate left/right side of  portal monitors, or to energy calibrate sub-set of  detectors
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A note about the spectrum display:

When there are more spectrum channels than pixels, multiple channels are summed together for display

As you zoom in and out, this is dynamically adjusted

The time-history plot does the same thing (but currently doesn’t allow zooming in/out)

Seems to be the least-misleading way to display the data in discernable way
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Nuclide ID
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Nuclide ID

The two primary tools to help you with nuclide ID in InterSpec are “Nuclide Search” and 
“Reference Photopeaks”

◦ InterSpec does not perform nuclide ID, but assists you, the competent analyst, with the ID

Before performing a nuclide ID, check your energy calibration
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First, check your energy calibration

A recent spectrum of  a known test source is best, but looking for background peaks in the primary 
spectrum or provided background may be good enough

You can provide “background” as a nuclide in the reference photo-peak tool to see most common 
background lines.
◦ Intensities will of  course vary with geographical location, but taller lines are generally more likely to be seen

11



Nuclide Search

The “Nuclide Search” tool provides you a list of  nuclides and reactions that have gammas, or optionally x-
rays, within specified energy windows. 
◦ You can have any number of  energy windows; results will have a gamma or x-ray in each window

◦ More windows narrows choices, but also increases probability peaks are from separate nuclides   

Clicking on a row in the results table will show reference lines for that nuclide – you then perform an 
inter-ocular assessment if  that is the correct nuclide for your spectrum
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Nuclide Search (cont.)

Clicking on the spectrum while the “Nuclide Search” tab is showing will put the energy you clicked 
on into the entry form; you can then click somewhere else, and it will fill in the next energy entry.

◦ If  you click near a peak (within 1.15*FWHM), the window-width will be filled out as well; for HPGe will be 
1 FWHM of  the peak, and lower resolution detectors will be 0.35*FWHM.
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Nuclide Search (cont.)

You can add or remove energy windows using the “+” and “-” buttons 
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Nuclide Search (cont.)

You can also specify a minimum half-life (of  the parent nuclide) 
◦ useful to eliminate the many very shortly lived nuclides; default is 100 minutes

You can also specify the minimum branching-ratio gammas must have to be considered for matching in 
the energy windows 
◦ Useful to eliminate nuclides that have a ton of  low-intensity gammas

◦ This actually filters based on the fraction of  gammas at each energy, at each stage of  decay, so some lower-BR 
gammas may still get included
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Nuclide Search (cont.)

◦ The energy matching is performed after decaying each nuclide, so that all prodigy are also considered in doing the 
match; the last column on the right show you which decay in the chain the gamma comes from

◦ All >4000 nuclides, and ~110,000 gammas are considered for the search 

◦ x-rays above ~10 keV are considered for all elements

◦ About 200 alpha,n, n,alpha, alpha-proton, n-capture, and inelastic n-scatter reactions are considered
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Nuclide Search (cont.)

You can sort results by any column by clicking on the table header

◦ The “Diff.” column is the sum difference between the search energies, and the matching gamma

◦ The “B.R.” column is, after decay, the relative intensity of  the gamma, to the largest intensity gamma of  the decay

◦ A heuristic is used to select the age to decay nuclides to based on if  it can reach secular equilibrium, half-life, and descendants half-life

◦ The “Profile” column is default, and almost always provides best result
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Nuclide Search (cont.)

The “Profile” column is a heuristic that ranges between -1 and 1 to give you a relative idea of  match quality

◦ Use this value relative to other search results – it doesn’t have an absolute meaning

◦ This value takes into account all peaks in the spectrum (the ones you’ve fit, plus ones returned from an auto-search), a 
few possible shielding and aging scenarios, relative amplitudes of  peaks, and gamma-lines that should-have created a 
peak but were no peak is observed

◦ Normally much better than ordering by “Diff.” or “B.R.”
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Reference Photopeaks

The “Reference Photopeaks” tab might be the most useful tool in InterSpec
◦ Gives you access to all >4000 nuclides, all x-rays, and ~200 reactions

◦ You can age nuclides, add shielding, DRF, and when appropriate just prompt products

◦ The reference lines on the spectrum provide additional information when you mouse-over them
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Reference Photopeaks (cont.)

The height of  the lines on the spectrum indicate relative intensity of  gammas/x-rays

◦ The heights are scaled so the highest intensity gamma line in currently displayed energy range has a height of  1, 
and all other lines are scaled linearly relative to this

◦ Even if  the spectrum y-axis is log, reference lines are linear – this best matches what is seen in the data-spectrum, given the continuum counts

◦ Shielding and DRF (if  entered) are taken into account in the chart-line amplitudes, but not on table values 
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Reference Photopeaks (cont.)

You can enter “nuclides” in fairly flexible, e.g., all the following are valid:

◦ Co56, Co-56, 56Co, 56 Co, 56-Co, cobalt 56, 56 Cobalt.

◦ Ho166m, Ho-166 meta, 166m Ho, 166m-Ho, holmium 166m

◦ Once you finish entering, will be converted to format like “Co56”

Reactions are entered like: “H(n,g)”, “Ge(n,n)”, etc

You can also enter “Background”, or an element name/symbol for its florescence x-rays 
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Reference Photopeaks (cont.)

To display lines for multiple isotopes, click “Add Another” and enter a new nuclide in

◦ Each nuclide can have a different shielding, age, etc.  Changing these fields only changes the current nuclide, if  
you want to alter a previously entered set of  reference lines, just type that name into the “Nuclide” field

◦ Line height scaling for currently visible energy range happens on a per-nuclide level

◦ If  you fit a peak while showing multiple nuclides, usually the best one is chosen to associate with a peak
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Reference Photopeaks (cont.)

Reference lines for nuclides will also include x-rays that are emitted during decays
◦ x-ray intensities are computed during decay calculations so their intensities are comparable to the gammas

◦ But be aware of  geometry or florescence effects

X-rays are shown as dotted lines on the spectrum

If  you just enter a element, its florescence x-rays are shown
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Reference Photopeaks (cont.)

Adding shielding can be useful to:
◦ Knock down high-intensity low-energy lines that are easily shielded

◦ Account for large amounts of  shielding

Clicking on the atom/shield symbol converts between generic and 
specific material 
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Other useful tools in InterSpec – Feature Markers

Not all peaks and features in a spectrum are caused by full-energy absorption of  a gamma/x-ray
◦ Escape peaks fall 511 keV and 1022 keV bellow the full energy peak 

◦ Sum peaks at double the actual energy

◦ Compton peaks or Compton edges can be confused for peaks, or scatter angle can be important to figure out

As you move the mouse on the spectrum, lines will be drawn on left and right to show where the source peak and feature peak 
would be for the current mouse position 

You can also try right-clicking on a peak and InterSpec will let you know about sum and escape peak possibilities
◦ Uses both the peaks you’ve fit, as well as the automated peak search results, so it works pretty well

If  there are some peaks left in the spectrum that you cant identify, this tool is worth a try, especially for HPGe
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Other useful tools in InterSpec – Energy Range Sum

Presence of  neutrons can be indicated by an elevated continuum, especially above 2614 keV; the 
“Energy Range Sum” tool provides a comparison of  foreground to background and secondary spectra

You can access it either from the “Tools” menu, or by Option+Shift+Drag on the spectrum

◦ Option+Shift+Drag will update in real-time as you move the mouse, and then bring the dialog up once you 
release the mouse
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Other useful tools in InterSpec – Dose Calc

This tool lets you compute expected dose for a given source and shielding combination, or if  you have 
measured dose, you can calculate activity, distance, or shielding, assuming you know the other quantities

◦ Uses a “full-spectrum” transport method, so does take into account scatter of  the shielding, which can contribute 
significantly to dose

◦ Provides some comparison dose values to provide context for those of  us that don’t deal with dose a lot

Do not use this tool for health and safety applications – has not been V&V’d to an appropriate level

◦ Tool does silently run some sanity checks when started, and you will be clearly notified if  they fail on your device 
for some reason (they shouldn’t, but JIC) 
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Other useful tools in InterSpec – Flux Tool

The Flux Tool uses the observed peaks in the spectrum, the DRF, and entered distance to give you 
the flux of  gammas at each energy, both per unit area, and into 4π

◦ Uses the peaks you fit in the spectrum

◦ Uncertainties are statistical from peak-amplitude only
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Other useful tools in InterSpec – Nuclide Decay Information 

Provide ingrowth and decay rates for a 
mixture of  nuclides over time
◦ Clicking on the chart gives decay 

products at that time

◦ You can export a CSV that includes the 
information and timing you want to 
work with in other applications

29

Provide ingrowth and decay rates for a 
mixture of  nuclides over time

◦ Clicking on a nuclide in decay chain 
gives more information about it

◦ Double-clicking on a nuclide in decay 
chain provides its decay products

◦ You can also show all decays through a 
nuclide (e.g., all possible parent nuclides)

A calculator for ageing sources

Double click on source text to 
change nuclide, activity, or 
initial age



Other useful tools in InterSpec – Gamma XS Calc

Quick easy way to check attenuation of  a gamma line through shielding, or to take into account 
distance or DRF 
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Other useful tools in InterSpec – File Parameters

Sometimes spectrum files have useful meta-data: date/time, detector model, RIID results, GPS 
coordinates, live/real time, etc.

You can edit most of  the meta-data to correct input data

◦ E.x., real time not included in the source data

◦ E.x., you are going to export the data in N42 format, and want to include GPS coordinates
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Other useful tools in InterSpec – 1/r2 calculator

For a source behind a wall, or inside a cargo container, and you can take two measurements

◦ Best to use with a peak count rate of  the source, but you can also use with dose-rate provided by detector

◦ There is a power law for mid-scatter and high-scatter dose measurements as well

◦ Allows you to optionally enter a background dose or peak rate
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Other useful tools in InterSpec – unit converter

Convert units on activity, dose, or distance

◦ A lot of  general purpose unit converters lack activity or dose, so this sometimes comes in useful
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Other useful tools in InterSpec – File Query Tool

Lets you recursively search a directory of  spectrum files, filtering on a bunch of  quantities

◦ Detector model, RIID results, GPS coordinates, filename, neutron or gamma CPS, live/real time, …

◦ Can be extended to search XML manifests that may accompany the spectrum files

◦ Pretty fast – depending on file sizes, CPU and hard-drive, ~50k files can take 1 minute for first search, and a 
second or two for subsequent searches

◦ See Options menu to persist cache between uses of  the tool

◦ Email InterSpec@sandia.gov for further information
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Other useful tools in InterSpec – GPS map

If  spectrum file contains GPS coordinates, you can view them on a map

When you zoom in on a subset of  measurement locations, you can sum all the visible points to a spectrum

Not enabled on all platforms
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Other useful tools in InterSpec – 3D plot for time data

Probably most useful for presentations – usually not that insightful
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Other useful tools in InterSpec – color theme

You can customize the colors of  almost everything, including the order of  colors used for reference 
lines, or you can assign nuclides to always be a certain color.

◦ You save themes to InterSpecs internal database, or you can export/import them from files for sharing 
across devices 

◦ On macOS and iOS if  you leave it on “Default”, will respect the OS dark/light theme
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Creating detector response 
functions 



Motivation/Overview

To determine an unknown source’s activity, or unknown shielding, or nuclide age you usually need to 
know the photo-peak detection efficiency of  the detector.  

To determine the detector response function (DRF), you will need some calibration data of  known 
sources with photo-peaks that span the energy range you might later be interested in.

◦ Common choices of  sources include Am-241, Cd-109, Co-57, Ba-133, Y-88, Cs-137, Co-60, Na-22,  and Th-
228, or Th-232, or U-232.  However, InterSpec should accommodate using nearly any test-sources.

The known calibration data is used to fit the Intrinsic Efficiency equation. I.e., the equation that 
describes the efficiency of  a gamma incident on the detector face to contribute to the full-energy 
photopeak for that gamma energy.

Characterization usually only has to be done once for a detector, and is usually valid for other 
detectors of  the same model
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How to create a DRF:

Step 1: take or acquire spectra of  known sources, at known distances 

Most portable or lab systems can use sources in the 10’s of  µCi range at 25 to 100 cm, for 5 to 30 
minute dwells.

If  any of  the sources have photo-peaks that overlap with background peaks, or the detectors seed-
source (e.x., Cs-137, Na-22), a background is also needed.

Test-source photo-peaks should have substantial statistics. I.e., a clearly visible, high statistics peak.

You will also need to know the detectors face surface area; InterSpec assumes a circular diameter, but 
if  other geometry you can just convert to the equivalent surface area (ex, a 7cm by 7cm rectangular 
face is equivalent to a circle with diameter 3.95 cm).
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How to create a DRF:

Step 2: Fit photo-peaks of  test-sources
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Open spectrum files by dragging them 

from the Explorer/Finder onto 

InterSpec.  Or you can use “Open 

File…” from within InterSpec 

Display reference photo-peaks for your 

test-source.

Fit peaks by double-clicking in their 

area on the chart.  Since reference lines 

are showing, the test-source nuclide 

will be associated with the peak.  You 

can also use the Peak Manager, or Peak 

Editor to associate nuclides with peaks



How to create a DRF:

Step 2 (continued):
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Open the next test-source spectrum in 

the same instance of  InterSpec.

And repeat peak-fitting.  

Do this for all test source measurements.

For the background there is no need to 

associate nuclides with the peaks



How to create a DRF:

Step 3: Open the “Make Detector Response” tool.
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How to create a DRF:

Step 4: Enter detector diameter.
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How to create a DRF:

Step 5: Select Peaks to use, and enter source information
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You can choose 

peaks from all of  the 

spectrum files you’ve 

used in your current 

session by scrolling 

down.

When you select a peak, 

an area will appear for 

you to enter source 

information



How to create a DRF:

Step 5 (continued): Entering source information
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You can have multiple sources for a single 

spectrum (especially for high-resolution 

detectors).  Interferences between sources 

will be accounted for.

Distances also must be entered for each 

source.

Selecting the “Age?” checkbox will allow 

you to age the source to calculate the 

activity at measurement time.

If  the sources spectrum changes 

significantly with age, you will also be 

prompted for age at the original assay date 

so the correct branching ratios can be 

calculated for the time of  measurement.

You can also opt to correct for shielding 

around the source.  However, shielding 

should be avoided or minimized for 

characterization measurements.



How to create a DRF:

Step 5 (continued): Background
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When you select to use a spectrum 

as background, all peaks in that 

spectrum that you choose to use will 

be considered background

When background 

subtraction occurs from 

test-sources, it will be 

indicated next to the 

normal text



How to create a DRF:

Step 6: Refine
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Clicking/tapping on the 

peak icon to the right on 

each row will let you 

preview the peak fit as a 

sanity check the fit is good

You can choose 

the number of  

parameters to fit.

You can fit the 

equation in energy 

units of  MeV, or 

keV

Your points should look continuous – you shouldn’t have any 

significantly off  of  the fit line; if  you do, check that source’s 

activity, distance, or that the correct gamma energy is associated 

with that peak 

The fit equation is continuously updated 

whenever you select/deselect peaks, or 

change source info, or other options 



How to create a DRF:

Step 6: Refine (cont)
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The peak resolution (Full Width Half  Maximum, 

FWHM) as a function of  energy is also fit for.

InterSpec doesn’t really use the FWHM information, so this information isn’t emphasized in the user interface.

You can choose to fit FWHM to either a power series equation, or the GADRAS-DRF resolution function.



How to create a DRF:

Step 7: Save
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To store the DRF into InterSpecs internal 

database, or export it, click the ”Save As…” 

button

Enter a useful name and description.  

Symbols such as slashes, backslashes, 

quotes, commas, semicolons, and question 

marks are not allowed in the name.

You can also choose to have InterSpec load 

this DRF automatically when you load 

spectra from either this specific detector, or 

this model of  detector.

You can also load this DRF from the 

“Previous” tab of  the “Detector Response 

Select” tool.



How to create a DRF: More Info

For further information, click on the help icon in the lower-left of  the tool.
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How to create a DRF:

Step 7: Save (cont)
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Clicking/tapping on the export data option 

will create and save a single N42 file with all 

the data used to create the DRF.  

The N42 file can be opened in other 

applications, but if  opened in InterSpec, all 

of  your fit peaks, source information, and 

the actual DRF will be included as well.

Exporting the DRF as a CSV is a nice way 

to use the DRF with other applications.  It 

also includes the efficiency data points, the 

equation as an absolute efficiency, as well as 

some further information



Selecting An existing DRF for use

To load a DRF, click on a detector widget anywhere available
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Selecting An existing DRF for use (cont.)

InterSpec comes with a number of  
generic GADRAS DRFs
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If  you have GADRAS installed, or some 
DRFs from it, you can point InterSpec to 
the detector directory, and then all the 
DRFs you have used in GADRAS will 
become available in InterSpec.
◦ You need to have at least opened the DRF 

in GADRAS so Efficiency.csv will have 
been created by GADRAS



Selecting An existing DRF for use (cont.)

You can also use DRFs defined by relative efficiency from a CSV format
◦ You can also use DRFs from LANL SimpleMass – just copy-paste the DRF section from SimpleMass into a 

TSV/CSV
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Selecting An existing DRF for use (cont.)

Once you “Accept” this DRF 
will be saved to InterSpecs
internal database, and available 
under the “Previous” section
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Its also common to have intrinsic or absolute efficiency 
of  a detector given as a function of  energy – you can 
enter that under the “Formula” section

Import single DRF from 
CSV/TSV, or GADRAS

Click “Set” after entering 
formula and other 
information



Selecting An existing DRF for use (cont.)57

DRFs you’ve previously used, 
or saved into InterSpecs
internal database are also 
available



Selecting An existing DRF for use (cont.)58

You can also set it so whenever you load data from a given detector model, or a specific detector, 
then the DRF you are about to select will automatically be loaded

◦ Convenient if  you work with the same detector models regularly 


